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In Office 2007 introduced the Ribbon, a major change to Office's interface that replaced the old menus and 
submenus with a graphical system that groups buttons for common tasks together in tabs. But Microsoft 
didn't go whole hog with it back then; Outlook, among other applications, was not given the full Ribbon 

treatment. 

New Icons: 

 

 
Microsoft Office 2010, brings a set of important if incremental improvements to the market-leading office 
suite. Among them: making the Ribbon the default interface for all Office applications, adding a host of new 
features to individual applications such as video editing in PowerPoint and improved mail handling in Outlook 
and introducing a number of Office-wide productivity enhancers, including photo editing tools and a much-
improved paste operation. 
The ribbon as introduced in 2007 - once you learned to use it, it's far easier to use than the old (pre 2007) 
Word interface.  

 

Word 2007  

 
Word 2010 
 
The Ribbon, by default, is divided into seven tabs, with an optional eighth one (Developer) that you can 
display by clicking File and choosing Options > Customize Ribbon and check Developer. Here's a rundown 
of the tabs and what each one does: 
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Home: This contains the most-used Word features, such as changing fonts and font attributes, 
customizing paragraphs, using styles, and finding and replacing text. 

 
Insert: As you might guess, this one handles anything you might want to insert into a document, such as 
tables, pictures, charts, hyperlinks, bookmarks, headers and footers, WordArt ... well, you get the idea. 
 
Page Layout: Here's where you'll change margins, page size and orientation, set up columns, align 
objects, add effects and so on. There are some gray areas between this tab and the Home tab. For 
example, on the Page Layout tab you set paragraph spacing and indents, while on the Home tab you set 
paragraph alignment and can also set spacing between lines. 
 
References: This tab handles tables of contents, footnotes, bibliographies, indexes and similar material. It 
also lets you insert a "Table of Authorities," which sounds like something straight out of a Soviet 

bureaucracy but in fact is a list of references in a legal document. 
Mailings: As the name says, this is where you'll go for anything to do with mailings, from something as 
simple as creating labels to the more daunting task of mail merges. 
 
Review: Need to check spelling and grammar, look up a word in a thesaurus, work in markup mode, 
review other people's markups or compare documents? This is the tab for you. 
 
View: Here's where to go when you want to change the view in any way, including displaying a ruler and 
gridlines, zooming in and out, splitting a window and so on. 
 
Developer: If you write code or create forms and applications for Word, this is your tab. It also includes 
macro handling, so power users might also want to visit here every once in a while. 

Each tab along the Ribbon is organized to make it easy to get your work done. As you can see below, each 
tab is organized into a series of groups that contain related commands for getting something done -- in 
our example, handling fonts. Inside each group is a set of what Microsoft calls command buttons, which 
carry out commands, display menus and so on -- in the example, the featured command button changes 
the font size.  

 
 
There's also a small diagonal arrow in the bottom right corner of some groups that Microsoft calls a dialog 
box launcher. Click it to display more options related to the group. 
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All that seems simple enough ... so it's time to throw a curveball at you. The Ribbon is context-sensitive, 
changing according to what you're doing. Depending on the task you're engaged in, it sometimes adds 
more tabs and subtabs.  

 
 
The biggest change is that you can now edit all the ribbons, not just the Quick access toolbar. Click 
File>Options>Customize Ribbons and add a new group into the ribbon of your choice. You can then put 
any tool into your group.  
 

 

 

The Ribbon takes center stage 
In this version of Office, all applications now share the common Ribbon interface, including Outlook, OneNote 
and all other Office applications, and SharePoint. Love it or hate it, the Ribbon is here to stay. 

 
 
In addition, the Ribbon has been tweaked. The Office button in the upper-left corner of the screen has been 
redesigned; it's now a File Tab rather than a large circle. Microsoft says that many people thought the circle 
was a branding icon, rather than a functional button that can be clicked on.  
 

 
 

Backstage View 
When you click the File button, it brings up what Microsoft calls Backstage View. Backstage is essentially one-
stop shopping for information about documents and common tasks you can perform, such as saving and 
printing files. It builds on, but goes well beyond, a similar feature in Office 2007.  
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Print Control Panel Under the Office Button: 
This is a fantastic addition, clicking ‘Print’ under the Office 2010 button opens a plethora of printing options. 
No need go through a ‘Print Wizard’ you can select all your print options from here & hit print 
Choosing Print from the menu on the left, for example, lets you preview your document before printing; you 
can also choose printer settings such as whether to print one-sided or collated, what margins to use, and so 
on. 
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In many instances, features in the Backstage View were present in Office 
2007, but hard to get at. In Backstage View, they're brought to one location. 
The Info tab in Backstage is particularly useful, giving you important 

information about your current file, such as the author and last time it was 
modified, and letting you review previous versions. 
 
Paste Preview 
Backstage View and the presence of the Ribbon in all applications are the 
most noticeable of the global changes to Office, but there are also other 
important ones. One of them at first glance appears to be a minor change, but 
could prove to be one of the biggest productivity enhancers in Office 2010 -- 
an improvement to the humble copy-and-paste operation. 
This simple task has become more difficult to use and confusing over the 
years because of the many different types of content you can now copy and 

paste into Office applications, including mixed text and graphics, tables and 
other complex content. Should you keep text only, for example, and should 
you keep the original formatting or the destination formatting, and which should be the default? With 
versions of Office before 2010, you'd make a decision, see the results, undo it and try another option. 
In the new version of Office, such trial and error is a thing of the past, thanks to Paste Preview. When you 
paste in content, you can now preview how it will look depending on your paste choice, making it much less 
likely that you'll have to undo a paste operation. Hover your mouse over each option, and you'll see the effect 
that using that option will have on the operation. When you see the option you want, simply make that 
choice. Paste Preview lets you set a default paste option as well. 
 
New Photo editing tools 

Also enhanced in Office 2010 are the photo editing tools, accessible via 

the Ribbon. Select a photo or picture you've placed in a document, and a 
Format tab will appear with tools for editing images in a variety of ways, 
including sharpening or softening, changing the contrast and color 
saturation, cropping, eliminating the background, and adding a variety of 
"artistic effects." 
In Office 2007, the tools available for doing this were rudimentary. You 

could change the brightness and contrast, for example, but without the same degree of control and visual 
feedback, and you couldn't remove backgrounds or add other effects. 
 
Built-In Screen Capture Tool: 
A really handy addition.  Word & PowerPoint both 
have the ‘Screenshot’ feature under ‘Insert’ & the 
useful part is that it caches screen shots of the 
currently open windows for one-click insert. At the 
same time also gives you the marquee select option. 
Screen shot of the ‘Screenshot’ feature: 
 
 
 
 
 

http://zapp5.staticworld.net/news/graphics/168292-five_original.jpg
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Background Removal Tool (for images): 
 

 
This is a feature that I’m sure quite a lot of us will be using. A neat addition to picture properties is 
‘Background Removal’. To show you the power of this tool, here is an image that I inserted into a Word 2010 
document: 

And after using the tool this is what I got 
 

 
 
 
 
Protected Mode: 
Every time you download a document from the internet & open it, Word 2010 will open it in a ‘Protected 
mode’ that won’t allow you to edit the document unless you enable editing of the document. 

 
You can edit which file types are to be opened in the protect 
mode from the Trust Center panel. Screenshot: 
 
 
 
New Smart Art Templates: 
In Office 2010 there are new Smart Art templates added. 
Existing categories have new templates & there’s a new 
category as well. Screen shot: 
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Author Permissions: 
The ‘Protect Document’ option under ‘Review’ in Office 2007 has now been renamed to ‘Restrict Editing’ & a 
new tab titled ‘Block Authors’ has been added. Screen shot of the option in Word 2007 & Word 2010 side-by-
side: 

 
 
 

A look at the new Outlook 
 
If you live in e-mail (and who doesn't?), you'll most likely be pleased with the new version of Outlook, which 
adds a variety of features designed to help solve the most common productivity problem -- e-mail overload. 
And, as noted above, the Outlook interface has changed radically, with the addition of the full-blown Ribbon.  
 
This puts most functions within easy reach -- functions that previously you might have had to navigate through 
several sets of menus to find. Apart from the addition of the Ribbon, Outlook's overall interface remains the 
same, with the same paned layout. 
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Faster mail handling 

 
One of the new features is called Quick Steps, which speeds up mail handling . Right-click on a message, and 
you can choose from a variety of actions to take on it -- moving the message to a specific folder, forwarding it 
to your manager, setting up a team meeting with its recipients, sending e-mail to an entire team and so on. 
You can easily add new items to the Quick Steps menu by choosing from a set of predefined Quick Steps or by 
creating your own using a wizard-like interface. You can also delete existing items or edit the items. 
 
Better message threading 
This new version of Outlook also tackles one of Outlook's perennial problems -- how poorly it follows threads 

of messages. In previous versions, the interface for doing this was confusing, so much so that most people I 
know, including me, rarely used it. 
 
In this version, following a thread is exceedingly easy. Right-click on an e-mail and select Find Related --> 
Messages in this Conversation, and you'll see a view of all messages in the conversation that can easily be 
followed, collapsed or expanded. You can also choose to arrange all your mail by conversations, using the 
Conversation View. The ability to follow threads may seem a small thing, but it's one of those small touches 
added in this version of Office that should pay big dividends in increased productivity. 
 
Clean up 

There's a related feature that helps cut down on e-mail clutter -- the 

ability to "clean up" a conversation. When you do this, you delete all of 
the unnecessary quoted and previous text in long e-mail threads; only 
unduplicated versions remain. However, once you do that, all of the 
quoted and previous text and e-mails are actually deleted, not just 
hidden, so use this feature carefully. It would be more useful if you were 

given the option of hiding the text, not completely deleting it. 
 
Not too much new in Excel 
Excel hasn't been touched as much as the other major applications in Office 2010, but there have been some 
useful additions. The most important is called "Sparklines" -- small cell-sized charts that you can embed in a 
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worksheet next to data to get a quick visual representation of the data. 
For example, if you had a worksheet that tracked the performance of 
several dozen stocks, you could create a Sparkline for each stock that 

graphed its performance over time, in a very compact way. 
Conditional formatting -- the ability to apply a format to a range of cells, 
and then have the formatting change according to the value of the cell or 
formula -- has been improved as well, including the addition of more 
styles and icons. 
 
As with other Office 2010 applications, Excel has new tools for sharing data with other people, including 
multiple people working on a document at a time. 
 

 
 

Protected view    Excel 2010 includes a Protected View, so you can make more informed decisions before 
exposing your computer to possible vulnerabilities. By default, documents that originate from an Internet 
source are opened in Protected View. When this happens, you see a warning on the Message bar, along with 
the option to enable editing. You can control which originating sources trigger Protected View. You can also 
set specific file types to open in Protected View regardless of where they originate. The file was opened from an Internet 

location     When you see the message in Protected View that states This file originated from an Internet 
location and might be unsafe. Click for more details., this is because the file is being opened from the 
Internet. Files from the Internet can have viruses and other harmful content embedded in them. We 
recommend that you edit only the document, if you trust its contents. The following image is an example:
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PowerPoint enters the video age 
If a picture is worth a thousand words, a video is worth at least ten thousand, but up until now PowerPoint's 
video features have been rudimentary at best. PowerPoint 2010 introduces a slew of enhanced video features, 

although in the Technical Preview not all were working properly. 

 
Key among the new features is a set of basic video editing tools built directly into PowerPoint. They're not as 
powerful as full-blown video editing software but work well for common tasks such as trimming and 
compressing videos and adding fade-ins and fade-outs. Highlight a video you've embedded in a presentation, 
and the tools appear in the Ribbon. 
 
Also useful is a set of video controls you can use during the presentation to pause, rewind, fast-forward and so 
on -- something that the previous version of PowerPoint did not have. 

 
 
One issue with video, though, is that PowerPoint does not play a wide variety of formats. It plays Audio Video 
Interleave (.avi) files as well as Windows Media (.wmv) files, but many other video formats require the 

installation of third-party codecs or add-in applications. 
New and very useful is the ability to embed videos from online video-sharing sites such as YouTube. To embed 
the video, you go to the site, find the code for embedding the video you want (the code is prominently 
displayed on most sites, including YouTube), and then paste it into PowerPoint. The video will play as part of 
your presentation, although you'll need an Internet connection to do so because the video will play from the 
original site, not from your PC. 
 
I had some problems with this feature. When I tried to embed the video, I received an error message. 
However, in YouTube when I deselected the "Include related videos" option for creating the embed code and 



 

Page 11 

then pasted the results in to PowerPoint, PowerPoint accepted the video and played it in the slide show -- 
once. When I tried to play it a second time, it didn't work. Presumably, this feature will be fixed in subsequent 
releases. 

 
In addition to video features, animations have been significantly improved in PowerPoint 2010. There are now 
far more animations to choose from and it's easier to use them via the Ribbon. 

You can also more easily edit your animations with a custom animation 

feature. And there's a nifty "Animation Painter" that lets you take any animation that you've selected or 
created, and apply that animation across multiple slides, without having to do it manually for each slide. 
As with Word, you can add screenshots to presentations with the new screenshot tool. There are some other 
nice additions, including new slide transitions and additional SmartArt graphics and themes, but the basics of 
PowerPoint remain the same. 

Broadcast Presentations To Your Clients: 

I say this is one sweet feature! Now you can broadcast your presentations by sending the intended 
viewer a URL, this works along with Office Live Workspaces & you need an account of the same.  
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Inserting & Editing Videos Is Painless & Fun: 

 

I’ll be honest; I never really enjoyed inserting videos in my presentations because it wasn’t a pleasant 
experience. It’s easier, with these new options: 

Compress Media While Saving Presentations 

As shown above, the all new file menu, known as 
— Backstage gives you options to compress the 
media files inserted in the presentation to reduce 
file size, it even gives an estimate of the 
presentation size. 

 

New Animations & Slide Transitions 

My favorite from the new ones is the Gallery 
transition effect. Another addition to transitions is 
that the % can be defined.  
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Save File Notification 

When closing an unsaved file, Office 2010 now lets you know that it has auto-saved a draft. 
Screenshot: 

 

 
Highlights from other apps 

The Microsoft Office family comprises more than Outlook, Word, Excel and PowerPoint, even if the other 
members of the family are not as well known. We won't cover every change to every family member, only the 
most important ones. 
 
The desktop publishing app Microsoft Publisher can now handle type in a more sophisticated way, with the 
same tools given to Microsoft Word for handling ligatures, small caps and other kinds of type. Templates can 
be more easily edited, and they can be shared with others from directly within Publisher. 
Microsoft also hopes that with this version of Office, OneNote -- an application that keeps track of notes and 
other data in multiple formats -- will finally come into its own. I've been a OneNote user for several years, and 
believe that it's one of the great underused Office applications. OneNote users will be pleased that it's been 
powered up in some important ways. 

 
The new Side Notes feature lets you write a note while using another Office application, and have that note 
automatically saved in OneNote. It's also now easier to capture information and copy it to OneNote, and 
navigation through notebooks has been improved. Searching for information in OneNote, which previously 
was not particularly useful, has been augmented as well. You can now specify whether to search on a page or 
in a section, section group, individual notebook or all notebooks. 
 


